1.1. Общая структура рабочей среды Ansys Workbench

Проекты в среде Ansys Workbench представляются в виде взаимосвязанных систем в форме блок-схемы, представленной на рисунке 3.1.1.

[image: image1.jpg]



Рисунок 3.1.1 Общий вид окна Ansys Workbench
При создании нового проекта Workbench автоматически генерирует шаблонную схему с указанием основных этапов его выполнения.

Рассмотрим основные принципы работы в среде Workbench.

На рисунке 3.1.2 показана структура основного рабочего окна Workbench.

Цифрой «1» обозначено окно «Toolbox» («Набор инструментов»). В нём представлены все возможные средства для проведения мультидисциплинарного анализа (их набор может отличаться в зависимости от типа лицензии и перечня установленных продуктов Ansys).

Окно под цифрой «2» «Project Schematic» представляет собой общую схему разрабатываемого проекта.

В окне «3» «Properties of schematic» отображаются свойства выбранного раздела.

В окне «4» «Messages» («Сообщения») по мере работы отображаются различные предупреждения и уведомления, выдаваемые Ansys.

Окно «5» «Progress» отображает процесс выполнения текущих операций.
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Рисунок 3.1.2 Структура основного рабочего окна Ansys Workbench
Для демонстрации работы Workbench создадим проект на примере гидродинамического расчёта. Для иллюстрации возможностей построения связей различных частей проекта, сделаем его состоящим из двух частей. В первой части проекта будет строиться геометрия и импортироваться сетка, а во второй будет проводиться настройка расчёта с использованием сетки, оттранслированной из первой части проекта.

Для создания проекта выбираем нажмём кнопку «New» на верхней панели (рисунок 3.1.3). Если до этого вы работали над каким-то другим проектом и не сохранили его, система предложит вам это сделать.

Теперь находим в окне «Toolbox», в подразделе «Component Systems» пункт «Mesh» («Сетка»), после чего, зажав левую кнопку мыши (далее - ЛКМ), перетаскиваем этот пункт в окно схемы проекта, как показано на рисунке 3.1.3.
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Рисунок 3.1.3 Создание нового проекта

Программа предложит назвать вновь созданный компонент. Выбираем для него имя, например – «Mesh1».

Теперь находим в окне «Toolbox», в подразделе «Analysis Systems» пункт «Fluid flow (CFX)» (если его нет, значит он не установлен) и точно таким же образом перетаскиваем в окно проекта.

В результате окно проекта должно выглядеть так же, как показано на рисунке 3.1.4.
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Рисунок 3.1.4 Окно проекта после создания компонентов «Mesh» и «Fluid Flow (CFX)»

Рассмотрим структуру компонентов «Mesh» и «Fluid Flow (CFX)»

В компоненте «Mesh1» присутствует всего два пункта «Geometry» («Геометрия») и «Mesh» («Сетка»).

Компонент «Fluid Flow (CFX)» состоит из следующих частей: «Geometry» («Геометрия»), «Mesh» («Сетка»), «Setup» («Настройка расчёта»), «Solution» («Решение задачи») и «Results» («Анализ результатов»).

Сейчас компоненты «Mesh1» и «Fluid Flow (CFX)» ещё ничем не связаны. Необходимо соединить их так, чтобы сетка, созданная в компоненте «Mesh1», транслировалась в компонент «Fluid Flow (CFX)».

Для этого необходимо с зажатой ЛКМ перетащить пункт «Mesh» из компонента «Mesh1» в пункт «Setup» компонента «Fluid Flow (CFX)», как показано на рисунке 3.1.5.
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Рисунок 3.1.5 Создание связи между компонентами

Результат данной операции показан на рисунке 3.1.6.
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Рисунок 3.1.6 Связанные компоненты

Легко заметить, что из компонента «Fluid Flow (CFX)» исчезли пункты «Geometry» и «Mesh», что естественно, поскольку теперь они транслируются из компонента «Mesh1».

Теперь сохраним проект с помощью кнопки «Save» на верхней панели.

Важно: Во избежание сбоев в работе, в наименовании пути сохранения проекта должны содержаться только латинские буквы. При этом само название проекта тоже должно быть набрано исключительно латиницей.

Заметим также, что вообще можно обойтись и без отдельного компонента «Mesh», а сразу создать и работать в компоненте «Fluid Flow (CFX)»

1.2. Работа в Ansys Design Modeler
Основным встроенным средством моделирования геометрии в пакете Ansys является редактор Ansys Design Modeler.

Для знакомства с ним, запустим Design Modeler, щёлкнув два раза ЛКМ по пункту «Geometry» в компоненте Mesh1, который мы создали в разделе 3.1.

При запуске программа предложит нам выбрать единицы измерения длины, которые мы хотим использовать (см. рисунок 3.2.1)
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Рисунок 3.2.1 Выбор единиц измерения

Как видно из рисунка, можно выбрать различные единицы измерения: метры (Meter), сантиметры (Centimeter), миллиметры (Millimeter), микрометры (Micrometer), футы (Foot) или дюймы (Inch). Программа позволяет также использовать единицы измерения, которые можно установить для всего проекта Workbench (по умолчанию это метры) – для этого необходимо установить галочку напротив «Always use project unit». Существует возможность подтверждения применения выбранной единицы измерения ко всему проекту по умолчанию. Для этого необходимо поставить галочку в окне «Always use selected unit».Наконец, можно подключить поддержку больших моделей, вплоть до 1000 км3 – галочка «Enable large model support». 

Для нашего примера выберем в качестве единиц измерения миллиметры и нажмём «OK».

Рассмотрим структуру основного окна Design Modeler (рисунок 3.2.2).

Окно 1 представляет собой дерево построения, где последовательно отображаются все операции, которые производятся с моделью.

Окно 2 – область построения, где изображается вид построенной нами модели.

Цифрой 3 обозначена панель инструментов.

В окне 4 отображаются основные свойства компонентов из дерева построения.
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Рисунок 3.2.2 Общая структура окна Ansys Design Modeler

Подробнее рассмотрим панель инструментов (см. рисунок 3.2.3). Как видно из рисунка, по умолчанию панель состоит из 8 основных блоков.
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Рисунок 3.2.3 Структура панели инструментов Ansys Design Modeler
Блок 1 содержит кнопки: 

· «Start over» («Начать сначала») – полностью очищает рабочее пространство, позволяя начать построение модели с нуля;

· «Save Project» - сохранение проекта;

· «Export» - экспорт геометрии в различных форматах;

· «Image capture» («Снимок экрана») – позволяет сделать снимок области построения и сохранить его в графическом формате.

Блок 2 – стандартные команды «Undo» и «Redo» («Отмена» и «Повторить»).

Блок 3 – различные фильтры выделения. Данные команды позволяют установить тип элементов (точки, ребра, поверхности, тела), которые мы хотим выделить с помощью курсора в области построения.

Блок 4 – команды для манипулирования изображением в области построения (вращение, панорамирование, масштабирование и т.д.).

Блок 5 – команды по управлению внешним видом линий модели в области построения.

Блок 6:

· выбор текущей плоскости;

· создание новой плоскости;

· выбор текущего эскиза;

· создание нового эскиза.

Блок 7:

· Кнопка «Generate» («Создать») – позволяет создать новый элемент модели. Применяется как финальная команда после задания всех параметров нового элемента (подробнее это будет продемонстрировано на примерах);

· Кнопка «Share topology» (Общая топология) используется для построения сеток в сборках, когда модель содержит несколько тел.

Блок 8 – команды построения модели:

· «Extrude» – вытягивание;

· «Revolve» – вращение;

· «Sweep» ​– вытягивание вдоль кривой;
· «Skin/Loft» – построение тела по сечениям;

· «Thin/Surface» – создание поверхности или тонкостенной оболочки;

· «Blend» – скругление;
· «Chamfer» – фаска;

· «Point» – создание точки;

· «Parameters» – задание параметрических размеров с помощью командной строки.

Дополнительные инструменты, которые могут понадобиться при построении модели  находятся в меню, в разделах «Create», «Concept» и «Tools». Некоторые из них будут рассмотрены по мере необходимости на примерах.

Итак, мы познакомились с интерфейсом Ansys Design Modeler и теперь можем приступать к построению геометрии. Следует отметить, что изложение материала в данном пособии предполагает, что читатель знаком с общими принципами трёхмерного моделирования и поэтому подробно эти вопросы рассмотрены не будут.

1.2.1.1. Построение геометрии реактивного сопла

В качестве первого примера рассмотрим пример построения геометрии реактивного сопла. 

Сразу же сделаем важное разъяснение. Дело в том, что в ходе расчёта течений газов и жидкостей прежде всего нас интересует построение геометрии самого объёма жидкости или газа, а не обтекаемого тела. Вследствие этого во многих задачах, где предметом интереса является только расчёт течения (без учёта процессов происходящих в самом твёрдом теле), геометрия и сетка строится только для жидкого объёма. При этом твёрдое тело представляется в виде «полости» в этом жидком объёме (см. рисунок 3.2.4)
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Рисунок 3.2.4 Геометрия тела и геометрия обтекающей среды

Для наглядности построим сначала трехмерную модель самого сопла, а уже потом преобразуем её в модель для расчёта течения, где стенка сопла будет представлена в виде "полости" в теле течения. Обычно на практике можно сразу построить модель течения, не строя геометрию твёрдого тела. С геометрией твёрдого тела работают в двух случаях: 

1) она уже построена в другой CAD-системе (SolidWorks, Catia, UG и т.д.) и затем экспортирована в Ansys;

2) интересна сопряженная задача, когда требуется определение параметров воздействия течения на твердое тело.

Построение модели начинается с выбора в дереве построения плоскости XY. Для этого щёлкаем по ней ЛКМ, после чего на панели инструментов нажимаем кнопку [image: image11.png]


 «New sketch». Теперь нам нужно перейти на панель «Sketching», вкладка которой находится внизу окна дерева построения (см.Рисунок 3.2.5)
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Рисунок 3.2.5 Включение панели Sketching

Сама панель Sketching показана на рисунке 3.2.6.
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Рисунок 3.2.6 Панель Sketching
Как видно из рисунка, панель состоит из 5 вкладок:

· «Draw» («Рисование») – здесь расположены основные инструменты для построения эскиза;

· «Modify» («Изменить») – вкладка, содержащая инструменты для редактирования;

· «Dimensions» («Размеры») – вкладка для проставления размеров;

· «Constraints» («Привязки») – создание привязок;

· «Settings» («Настройки») – управление настройками рабочего пространства эскиза.

Сейчас нас интересует вкладка «Draw».

Для рисования будем использовать инструменты Line (прямая), Tangent Line (касательная прямая) и Arc by Tangent (касательная дуга). Отметим, что рядом с курсором, когда мы наводим на какую-либо ось появляется буква C (centerline) – это означает, что начальная точка нашей линии будет лежать точно на оси. Если появляется буква P (point) – это значит, что наша линия будет начинаться из какой-то конкретной, уже построенной точки (например, из конца другого отрезка или из начала координат). Буква H (horizontal) означает что изображаемая прямая будет строго горизонтальна, а буква V (vertical) – что строго вертикальна.

Начнём рисование из центра координат, проведя прямую линию. Размер в данном случае пока не имеет значения. После этого нарисуем горизонтальную линию, выходящую из конца вертикальной. Затем – дугу, касательную к нашей прямой. После этого прямую, касательную к дуге, а затем две последовательных касательных дуги.

В результате всех манипуляций у нас должен получиться эскиз, изображённый на рисунке 3.2.7.
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Рисунок 3.2.7 Эскиз контура сопла

Теперь проставим необходимые размеры. Для этого перейдём на вкладку «Dimensions». Её структура представлена на рисунке 3.2.8.
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Рисунок 3.2.8 Панель простановки размеров

Интуитивно здесь всё понятно, однако кратко перечислим назначения клавиш:

· размер общего вида (в зависимости от конкретной геометрии это может быть длина, диаметр, угол и т.д).

· горизонтальный размер (можно задавать горизонтальное расстояние между двумя точками, точкой и осью и т.д.);

· вертикальный размер (можно задавать вертикальное расстояние между двумя точками, точкой и осью и т.д.);

· длина/расстояние;

· радиус;

· диаметр;

· угол;

· полуавтоматическая простановка размеров в эскизе;

· редактирование размеров;

· перемещение полки размера;

· анимация размера (указанный размер будет циклично изменяться);

· настройка отображения (можно выбрать, показывать ли наименование размера, его значение или обе эти опции одновременно).

Начнём проставлять размеры с радиуса выходного сечения сопла. Для этого проставим расстояние от конечной точки нашего эскиза до оси, выбрав тип размера «Vertical». Во время простановки самого размера можно щёлкнуть ПКМ для входа в контекстное меню, где среди прочих команд находится команда «Cancel» («Отмена») и «Edit Name» («Редактировать имя размера»).

После простановки размеров, из значения устанавливаются в окне «Details View» (окно 4 на рисунке 3.2.2). Как только мы установили на нашем эскизе размер выходного сечения сопла, он появился в окне «Details View» под названием V1. Данное название можно изменить, если выбрать в области построения размер и нажать ПКМ, а затем выбрать из контекстного меню команду «Edit Name/Value» («Редактировать имя/значение размера»).

Остальные размеры эскиза мы предлагаем читателю проставить самостоятельно, руководствуясь рисунком 3.2.9. Рекомендуется сначала проставить все размеры на эскизе, а потом уже присваивать им значения.
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Рисунок 3.2.9 Размеры сопла

Значения размеров следующие:

	A1
	H1
	H2
	R1
	R2
	R3
	V1
	V2
	V3

	45о
	175 mm
	60 mm
	10 mm
	15 mm
	400 mm
	70 mm
	30 mm
	15 mm


Замечание: если не удаётся проставить показанный на рисунке угол, то во время простановки данного размера необходимо кликнуть ПКМ и в контекстном меню выбрать пункт «Alternate angle» («Изменить угол»)

Закончив с простановкой размеров, создадим твёрдое тело. Для этого применим операцию вращения [image: image17.png]


.

В окне «Details view» отобразятся свойства операции вращения (см. рисунок 3.2.10)
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Рисунок 3.2.10 Свойства операции вращения

Как видно из рисунка, необходимо задать ось вращения (Axis), после чего нажать кнопку «Apply» («Применить»).

В пункте «Operation» можно выбрать, является ли операция добавлением материала в текущее тело («Add material»), добавление материала в новое тело («Add Frozen»). В случае, когда в проекте уже присутствует созданная твердотельная геометрия, данном пункте можно также выбрать опцию выреза материала («Cut material»). 

В пункте «Direction» («Направление»), задаётся направление выдавливания («Normal» нормально к поверхности эскиза; «Reversed» - противоположное ему; «Both Symmetric» - оба направления, симметрично; «Both Asymmetric» - в оба направления антисимметрично). Оставляем в данном пункте опцию «Normal»

Следующий пункт – задание общего угла вращения. Оставляем 360o.

As Thin/Surface – создание тонкостенной геометрии. Следует проставить опцию «Yes», после чего программа предложит задать толщину стенки во внешнем (inward thickness) и внутреннем (outward thickness) направлении. Сделаем толщину во внутреннем направлении равной 1 мм, а толщину во внешнем оставим равной нулю.

После этого нажимаем кнопку [image: image19.png]“ Generate



. Получившееся сопло показано на рисунке 3.2.11
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Рисунок 3.2.11 Трёхмерная модель сопла

На этом построение геометрии самого сопла закончено, приступаем к построению геометрии среды.

Во многих задачах, особенно связанных со сверхзвуковыми течениями, помимо расчёта процессов внутри конструкции бывает необходимо учесть процессы, происходящие в окружающей среде. Поэтому, изображая «тело» течения, мы захватим не только внутреннюю полость сопла, но и часть внешнего потока, куда истекает реактивная струя.

Для начала «заполним» внутреннюю часть нашего сопла телом потока. Для этого будем использовать команду [image: image21.png]| Fill



(«Заполнить»), которая находится в меню Tools.

Существует два типа построения геометрии полостей (пункт «Extraction Type» в окне «Details View»). Первая – путём указания поверхности, которая эту полость ограничивает (опция «By cavity»), либо путём выбора твёрдых тел, образующих замкнутую полость «By caps»).

Выбираем первый способ. Для этого необходимо выбрать внутренние стенки полости. Данная задача может оказаться непростой, если не быть знакомым с интерфейсом выделения поверхностей Workbench.

Для начала повернём сопло к себе горловиной, как показано на рисунке 3.2.12
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Рисунок 3.2.12 Вид на горловину сопла

Выбираем донную поверхность сопла, после чего средней кнопкой мыши (СКМ) поворачиваем сопло в профиль и затем зажимаем на клавиатуре клавишу Ctrl.

Поочерёдно выбираем поверхности внутренних стенок сопла. Важно при этом не отпускать клавишу Ctrl, иначе предыдущие выделения сбросятся.

Выбираем первую поверхность, после чего в левом нижнем углу области построения появится интерфейс выбора (см. рисунок 3.2.13, интерфейс отмечен стрелкой)
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Рисунок 3.2.13 Интерфейс выбора поверхностей

Данный интерфейс сообщает нам, что в том месте области построения, где мы щёлкнули ЛКМ с целью выбора поверхности, находятся, перекрывая друг друга, сразу две поверхности. При этом красным отмечена выделенная в данный момент поверхность.

Чтобы выбрать закрытую от нас внутреннюю поверхность сопла, нам необходимо кликнуть на второй из двух представленных в интерфейсе плоскостей, так, что они обе станут красными (см. рисунок 3.2.14а). После этого нужно нажать на переднюю поверхность ЛКМ, чтобы её рамка стала чёрной (см. рисунок 3.2.14б). 

[image: image24.png]



Рисунко 3.2.14 Процесс выбора поверхности из множественных перекрывающихся

Данную операцию необходимо проделать со всеми поверхностями, формирующими стенку сопла, не отпуская при этом, как было уже указано выше, клавишу Ctrl.

После этого в окне «Details View» нажимаем Apply. Программа при этом должна отметить, что у нас выбрано 6 поверхностей («6 faces»).

Теперь мы готовы сгенерировать заполнение полости (кнопка [image: image25.png]“ Generate



)

В самом конце дерева построения должно отобразиться, что у нас теперь две детали и два тела («2 parts, 2 bodies»)

Таким образом, мы построили тело течения внутри сопла. Осталось создать геометрию тела внешнего течения за соплом. Для этого создадим ещё один эскиз в плоскости XY.

Данный эскиз представляет собой трапецию с основанием, отстоящим от днища сопла на 120 мм (см. рисунок 3.2.15). Отметим, что форма области выбирается.
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Рисунок 3.2.15 Эскиз для создания области внешнего потока

Размеры на эскизе:

	H_out1
	H_out2
	V_out1
	V_out2

	600 mm
	120 mm
	200 mm
	350 mm


Проставив указанные размеры, создадим на основе эскиза операцию вращения, выбрав в качестве оси вращения ось X, а в поле «Operation» указав опцию «Add frozen» (данная опция указывается для того, чтобы в результате данной операции было создано отдельное тело).

Нажимаем [image: image27.png]“ Generate



. Счётчик тел в дереве построения должен теперь показывать наличие трёх деталей и трёх тел (3 parts, 3 bodies).

Создавая тело внешнего потока, мы не заботились о его пересечении с телом стенки сопла, изобразив простую трапецию. Следовательно, теперь нам необходимо «вычесть» тело стенки сопла из тела внешнего потока. Для этого создадим булеву операцию  [image: image28.png]@ eoolean



 («Boolean operation»).

Данная операция находится в пункте меню Create на верхней панели.

На панели «Details View» выбираем в пункте «Operation» опцию «Subtract» («Вычесть»). Теперь нам нужно выбрать «уменьшаемое» («Target Bodies») и «вычитаемое» («Tool Bodies») тела. В качестве первого выбираем в области или в дереве построения созданное нами тело течения. В качестве второго – тело стенки сопла.

В свойствах операции также присутствует пункт «Preserve tool bodies?» («Сохранить вычитаемые тела?»). Мы оставляем в данном пункте опцию «No» («Нет») и в результате данной операции тело стенки сопла будет удалено.

Нажимаем [image: image29.png]“ Generate



.

В результате операции у нас должно остаться две детали и два тела

Теперь нам необходимо создать вторую булеву операцию, объединив тела течения внутри и снаружи сопла в единое тело.

В пункте «Operation» теперь выбираем опцию «Unite» («Объединить»), затем выбираем два оставшихся у нас тела, применяем выбор и нажимаем [image: image30.png]“ Generate



.

После данной операции счётчик тел в дереве построения должен отметить наличие всего лишь одной детали и одного тела.

Фактически построение геометрии тела течения закончено. Остался лишь один немаловажный вопрос. Дело в том, что рассматриваемое здесь течение осесимметричное и при его расчёте нерационально рассматривать всю расчётную область в полном объёме (потребляется слишком много вычислительных ресурсов). Вместо этого обычно рассматривают лишь небольшой сектор расчётной области, а на секущих плоскостях сектора ставят условия симметрии. Следовательно, необходимо вырезать из нашей геометрии сектор.

Для этого создадим эскиз в плосокости YZ, выбрав эту плоскость в дереве построения и нажав на кнопку [image: image31.png]


 «New sketch».

Вид данного эскиза показан на рисунке 3.2.16. Он представляет собой две прямых линии, выходящих из начала координат.

Размеры на эскизе:

	A1
	A2
	L3
	L4

	30o
	30o
	400 mm
	400 mm


После простановки размеров выбираем операцию вытягивания [image: image32.png]Bextrude



, в качестве операции в пункте «Operation» выбирая «Add frozen», а в качестве размера – 750 мм. При этом в пункте «As Thin/Surface» ставим Yes и указываем нулевую толщину по направлениям Inward и Outward. Нажимаем [image: image33.png]“ Generate



.

Теперь с помощью получившихся поверхностей нам необходимо рассечь наше тело. Для этого используется команда[image: image34.png]) Slice



 («Разрезать»), находящаяся в меню «Create».

В качестве типа сечения («Slice type») выбираем «Slice by surface» («Сечение поверхностью»). Затем в области построения выбираем одну из двух построенных ранее плоскостей. Применяем выбор, и нажимаем [image: image35.png]“ Generate



.
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Рисунок 3.2.16 Эскиз плоскостей симметрии

После этого проделываем то же самое со второй плоскостью.

Теперь остаётся лишь удалить ненужные нам тела. Для этого в меню «Create» выбираем команду [image: image37.png]i Body Operation



 («Операция с телами»).

Данная команда представляет обширный выбор различных действий с телами, начиная от создания зеркальных копий тел (опция «Mirror») и заканчивая упрощением сложной геометрии (опция «Simplify»).

Сейчас нам необходима опция Delete в пункте «Body operation». Выбираем её, после чего выделяем в дереве построения все тела, кроме самого первого. Применяем выбор и нажимаем [image: image38.png]“ Generate



.

В результате должно остаться тело, изображённое на рисунке 3.2.17, а счётчик тел в дереве построения должен указывать наличие одного тела и одной детали.

На этом построение геометрии завершено и остается лишь сохранить проект.
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Рисунок 3.2.17 Окончательный результат

1.3. Построение сеточной модели реактивного сопла

Импортируем геометрию сопла: File > Import Geometry > ParaSolid, выберем файл Nozzle.x_t и укажем единицу измерения длины Millimeter, нажмём OK. Полученная геометрия будет содержать два семейства: NOZZLE – самого сопла и FLUID – семейства, содержащего геометрию расчётной области (газовая область внутри сопла и область истечения). Семейство NOZZLE необходимо удалить за ненадобностью.

Далее, распределим существующую геометрию по семействам:

INLET – семейство для задания ГУ «Вход». Соответствует блоку форсунок в камере сопла;

OUTLET – семейство для задания ГУ «Выход». Поверхность, лежащая напротив среза сопла;

PRIODIC_L и PERIODIC_R – поверхности для задания ГУ «Периодичность»;

OPENING – поверхность для задания ГУ «Открытая граница» (Opening);

OPEN_IN – поверхность на которой можно задать ГУ «Открытая граница» или «Вход», что упрощает процесс счёта и необходимо при моделировании полёта ракеты (истечение с спутный поток);

AXES – содержит только осевую линию. Данное семейство необходимо только для построения блочной топологии сопла;

WALL_1 и WALL_2 – стенки сопла, внутренняя и внешняя, соответственно;

FLUID – материальная точка. После распределения геометрии по семействам, исходное семейство с именем FLUID исчезнет, как не содержащее геометрию. Освободившееся имя можно использовать повторно. На рисунке 4.6.1 представлена геометрия расчётной области сопла и Дерево модели. По цвету имени семейства в Дереве модели и цвету геометрии расчётной области можно определить принадлежность геометрии к тому или иному семейству.
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Рисунок 4.6.1 Геометрия расчётной области, распределённая по семействам (семейство PERIODIC_R – погашено)

Особенностью данной модели является периодичность боковых поверхностей (семейства PERIODIC_L и PERIODIC_R), т.е если одну из поверхностей провернуть вокруг оси, то можно получить совпадение всех точек геометрии с точками геометрии другой поверхности. Данная периодичность называется «периодичностью вращения». Задание периодичности при создании сеточной модели необходимо для того, чтобы узлы сетки, расположенные на одной из периодичных поверхностях отличались от соответствующих узлов другой поверхности только по угловой координате. При решении задачи параметры потока с одной поверхности будут передаваться на другую без осреднения. Что повышает точность расчёта.

Периодичность задаётся следующим образом: вкладка Mesh > Global Mesh Setup [image: image42.png]


 > Set up Periodicity [image: image43.png]


. Активизируется функция Define periodicity, выбирается Rotating periodic. В окне Axis задаётся ось вращения (в единичных векторах i, j, k) – в нашем случае ось вращения OX, следовательно вводим 1 0 0 (через пробел). В окне Angle задаём угол периодичности. В представленном примере угол периодичности 30°. Нажимаем OK.

Установим следующие параметры сетки:
	Global Mesh Size
	Max element – 20.

	Part Mesh Setup
	AXES > max size – 2

INLET > max size – 3

WALL_1 > max size – 3; tetra size ratio – 1.5; tetra width – 1

WALL_2 > max size – 5.

	Surface Mesh Setup
	Выбираем торцевую поверхность сопла (принадлежит семейству WALL_1) > Maximum size 0.5


Далее Compute Mesh > Compute.

Для призматического слоя зададим следующие параметры: Prism Meshing Parameters [image: image44.png]


 > Initial height – 0.05, Number of layers – 10. Остальные настройки оставим «по умолчанию». Создадим призматический слой на поверхностях семейств WALL_1 и WALL_2 (Compute Mesh > Prism Mesh, выбрать семейства – Select Parts for Prism Layer, Compute).

Проведём процесс выглаживания сетки: вкладка Edit Mesh > Smooth Mesh Globally [image: image45.png]


. Критерий сглаживания Criterion – Quality, целевое значение Up to value – 0.2, число итераций сглаживания Smoothing iterations – 20.

После описанных операций должна получиться сеточная модель газовой расчётной области реактивного сопла с качеством сетки более 0.15 по параметру Quality (низкокачественные элементы находятся возле оси сопла) и числом элементов около 243.000.

При желании и в качестве тренировки можно попробовать различные варианты задания параметров сетки, а также использования функции Density для более подробного описания потока в местах скачков уплотнения (например, в горле сопла).

1.3.1. Создание блочной структуры реактивного сопла

Перед построением блочной топологии расчётной области реактивного сопла, необходимо выгрузить из проекта имеющуюся сетку (чтобы не мешалась в дальнейшей работе): File > Mesh > Close Mesh. Далее, в Дереве модели оставим включенными только точки и кривые, остальные геометрические объекты (поверхности и тела) для построения блока не нужны и будут только загромождать рабочее окно лишним изображением.

Перейдём на вкладку Blocking и построим исходный блок (Create Block > Initialize Blocks, Part – FLUID).

Периодичность геометрии и сетки задана ранее. Теперь необходимо задать периодичность и для блока: Edit Block [image: image46.png]


 > Periodic Vertices [image: image47.png]


. Укажем попарно на вершины блока: 22 и 26; 38 и 42; 37 и 41; 21 и 25. Блок немного деформируется – ничего страшного. Если включить функцию Дерево модели > Blocking > Vertices (если галочка не стоит – поставьте) > ПКМ > Periodic, то на блоке появятся красные стрелки, соединяющие вершины блока. Данные стрелки показывают, какие вершины периодичны между собой. В этом же меню можно включить и нумерацию вершин (Numbers). Результат задания периодичности представлен на рисунке 4.6.2. После проверки периодичности вершин, функцию отображения периодичности можно отключить.

[image: image48.png]



Рисунок 4.6.2 Блок с периодичными вершинами

Так как из-за задания периодичности нижняя часть блока (ближняя к оси сопла) довольно подвижна и при выполнении каких-либо операций будет сильно деформироваться, то лучше часть вершин и рёбер привязать на данном этапе к геометрии. А именно привяжем вершины 38 и 42 к соответствующим точкам (функция Associate Vertex [image: image49.png]


); рёбра 38-42, 41-41, 37-38, 26-42, 22-38, 25-26 и 21-22 к соответствующим кривым геометрии (функция Associate Edge [image: image50.png]


). При помощи функции Move Vertices переместите вершины 21, 25, 37 и 41 блока как показано на рисунке 4.6.3.
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Рисунок 4.6.3 Перемещение вершин блока

Вполне вероятно, что при перемещении вершин возникнет ситуация, показанная на рисунке 4.6.4 – одна из периодичных вершин сместилась не в ту сторону после перемещения другой вершины. Ничего страшного не произошло, возьмите вершину (в данном случае 41) и переместите её на соответствующую ей кривую (в данном случае – вертикальную голубую). Ошибка исчезнет.
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Рисунок 4.6.4 Ошибка с расположением вершины блока

При помощи функции Split Block [image: image53.png]


 разбейте существующий блок горизонтальным сплитом. Далее, при помощи функции Merge Vertices [image: image54.png]


 > Collapse Blocks [image: image55.png]


 схлопните нижний блок. Для этого выберете ребро 69-73, подтвердите выбор нажатием КМ (ребро окрасится в красный цвет). Выберете нижний блок (рисунок 4.6.5, а) и подтвердите нажатием КМ. Результат использования функции представлен на рисунке 4.6.5, б.
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Рисунок 4.6.5 Схлопывание блока: а)выбор ребра и блока; б) результат операции

Вершины 73 и 74 спроецируйте в точки на оси сопла.

Далее, разбейте блок двумя сплитами – горизонтальным и вертикальным (расположенным, примерно, в плоскости среза сопла). При помощи функции Delete Block [image: image58.png]


 удалите верхний левый блок (рисунок 4.6.6).
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Рисунок 4.6.6 Удаление блока

Спроецируйте вершины 87 и 88 в соответствующие точки семейства INLET, вершины 107 и 108 спроецируйте в нижние точки торца сопла, а вершины 89, 90, 111 и 112 переместите до придания сходства с изображением на рисунке 4.6.7.
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Рисунок 4.6.7 Привязка и перемещение вершин

При помощи функции Split Block добавим сплиты: два вертикальных – для описания горла сопла, один горизонтальный (над уже существующим) – для описания стенки сопла. Спроецируем рёбра на соответствующие кривые, а вершины – в соответствующие точки геометрии. В районе горла сопла достаточно рёбра споецировать на продольные кривые. После операции проецирования переместим вершины таким образом, чтобы добиться сходства с изображением на рисунке 4.6.8 и 4.6.9.
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Рисунок 4.6.8 Блочная структура сопла
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а)                                                                          б)

Рисунок 4.6.9 Привязка рёбер и вершин в районе: а) горла сопла; б) выходной кромки сопла

Для описания участка геометрии расчётной области, охватывающего часть атмосферы перед срезом сопла необходимо достроить блок. Достройка блока путём вытягивания его из существующей поверхности блока осуществляется функцией Create Block > Extrude Face(s) [image: image64.png]


. Выбирается поверхность блока, выбор подтверждается нажатием КМ, и не отпуская колёсика мыши двигаем саму мышь в нужном направлении, чтобы получился блок, соизмеримый с геометрической областью (рисунок 4.6.10).
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Рисунок 4.6.10  «Вытягивание» блока: а) выбор поверхности; б) результат построения блока

Полученные вершины не периодичны между собой. Задайте периодичность вершин 194 и 196, 195 и 197 при помощи функции Periodic Vertices [image: image67.png]


. Спроецируйте вершины и рёбра на соответствующие элементы геометрии.

Результатом последовательного разбиения блока на подблоки, удаления и создания новых подблоков, привязки вершин и рёбер к элементам геометрии является блочная топология расчётной области реактивного сопла, представленная на рисунке 56.11. Особо обратите внимание на цвета вершин и рёбер – если они не соответствуют изображению на рисунке, необходима привязка. Сохраните проект.
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Рисунок 4.6.11 Общий вид блока сопла

Следующим шагом в создании сетки является распределение количества узлов по рёбрам блоков, задания размеров элементов и сгущения. Для начала необходимо задать число узлов на рёбрах блоков и поставить коэффициенты сгущения (функция Edge Params, Ratio 1 и 2 - 1.2. для всех рёбер). Для удобства задания начального распределения необходимо включить функцию Copy Parameters и выбрать способ To All Parallel Edges. На рисунке 4.6.12 рядом с каждым ребром показано число узлов. Для рёбер, описывающих толщину стенки, число узлов – 6, для продольных рёбер области истечения – 60.
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Рисунок 4.6.12 Распределение числа узлов по рёбрам блоков

Далее необходимо задать размер пристеночного элемента, но, прежде всего, необходимо заменить метод копирования параметров сетки на метод To Selected Edges. При данном методе параметры с одного ребра будут копироваться на другое только в случае выбора последнего. На примере рёбер внутри сопла покажем работу данного метода. Выберем ребро 73-87 (рисунок 4.6.13), зададим Spacing 2 – 0.05 (данный параметр соответствует пристеночному элементу). Так как при имеющимся числе узлов (20) требуемый параметр сгущения (1.2) не выдерживается, необходимо добавить узлов на данном ребре (35 узлов позволяет держать параметр Ratio в пределах заданного значения). Далее перенесём эти настройки на другие рёбра (146-149, 146-150 и т.д.). Для этого в разделе Copy функции Edge Params нажмём кнопку Edge(s) [image: image70.png]


 и выберем все необходимые рёбра. Нажмём Apply или колёсико мыши. К сожалению, ICEM CFD не всегда точно переносит параметры настройки рёбер (это касается и при переносе на все параллельные рёбра), поэтому в особо важных местах необходима проверка и, при необходимости, корректировка настроек. Для внешней стенки зададим размер пристеночного элемента побольше (скорость потока намного меньше чем в сопле, и точный расчёт потока в этой области нам не важен).
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Рисунок 4.6.13 Задание параметров сетки на рёбрах внутри сопла

Особенностью блоков с заданной периодичностью является то, что помимо периодичности вершин (которые задаются в самом начале и в ходе работы редактируются редко) необходимо выдерживать периодичность настроек рёбер, соединяющие эти вершины. То есть, при изменении настроек на одном ребре обязательно надо переносить эти настройки на периодичное ему ребро. В представленном примере, периодичными рёбрами являются рёбра 87-150 и 88-149, и т.д.

При помощи функции Match Edges [image: image72.png]


 выравним размеры соседних элементов на соседних рёбрах (рисунок 4.6.14, а). Необходимо помнить о наличии периодичности в сеточной модели. На рисунке 4.6.14, б показан результат выравнивания размера элементов. Обратите внимание на элементы в горле сопла и в районе семейства OUTLET, при необходимости примените функцию Match Edges.
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                          а)                                                             б)

Рисунок 4.6.14 Выравнивание размеров элементов на соседних рёбрах:    а) до операции; б) после операции

Для того, чтобы уменьшить перекос сетки вдоль оси струи (после среза сопла), необходимо увеличить число узлов на продольном ребре (с 60 до 70). Уменьшить Ratio 1 до 1.12 для ребра, привязанного к оси сопла, и увеличить Ratio 1 до 1.32 для рёбер, идущих от кромки сопла и вдоль оси струи.

Для лучшего описания потока сеточными элементами используется функция Edit Edge [image: image75.png]


 > Split Edge [image: image76.png]


. Для этого укажем на ребро 146-149 (в горле сопла), на ребре появится узел или опорная точка и само ребро искривится. Перемещая эту точку при помощи функции Move Vertex можно изменять кривизну ребра, что влияет на кривизну сетки. На одном ребре, при необходимости, можно создать несколько опорных точек. Создадим при помощи этого способа по одной опорной точке на рёбрах 146-150, 172-175 и 172-176, 104-107 и 104-109 (срез сопла). Результат показан на рисунке 4.6.15, а. Для придания необходимой кривизны, переместите опорные точки так, как показано на рисунке 4.6.15, б.
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Рисунок 4.6.15 Искривление рёбер: а) до перемещения опорных точек;     б) после перемещения опорных точек

Периодичность на созданные опорные точки не распространяется, устанавливать совпадение опорных точек (для совпадения кривизны рёбер) необходимо «на глаз». Для упрощения этой задачи можно выставить модель таким образом, чтобы все периодичные вершины блока совпадали. Для этого наведём курсор мышки на систему координат в правом нижнем углу окна модели и добьёмся появления отрицательного направления вектора OY (необходимо навести курсор в это место). Нажмём на появившуюся серую ось (рисунок 4.6.16). Вся модель повернётся так, что вектор –OY будет направлен перпендикулярно рабочему окну и на нас.
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Рисунок 4.6.16 Система координат с отрицательным направлением оси

Опорные точки перемещаются до образования необходимой кривизны ребра и совпадения в проекции на плоскость XOZ опорных точек соответствующих периодичных рёбер. На рисунке 4.6.17 показан результат применения изгиба рёбер.
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Рисунок 4.6.17 Результаты использования изгиба рёбер: а) до операции;  б) после операции

Снять изгиб рёбер можно при помощи функций Unsplit Edge [image: image82.png]


 или Unlink Edge [image: image83.png]


.

На этом основные операции по созданию пре-сетки расчётной области сопла закончены. Необходима проверка качества пре-сетки (функция Pre-Mesh Quality Histograms). В целом, качество сетки должно быть хорошим за исключением отношения сторон элемента (Aspect Ratio). Для улучшения этого параметра необходимо добавлять узлы на соответствующие рёбра. Но это повлечёт увеличение количества элементов сеточной модели расчётной области сопла.

После проверки качества пре-сетки и улучшения параметров (при необходимости), генерируется неструктурированная сетка. Если оставить включёнными только семейства PERIODIC_L и PERIODIC_R, а в Дереве модели > Mesh > ПКМ и включить Periodicity, то появятся линии, соединяющие соответствующие периодичные элементы (рисунок 4.6.18).
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Рисунок 4.6.18 Визуализация периодичности сеточной модели

Сохраните проект и создайте файл, содержащий неструктурированную сетку в формате *.cfx5.

На этом данный пример закончен.
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